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Smoke Layer Height and Heat Flow through a Door 
In this tutorial you will simulate a growing fire in the corner of a 5m x 5m room. The room has a 1m 

doorway. You will learn how to measure smoke layer height in the compartment and heat flow though 

the doorway. The door will be initially closed, but will open after the smoke detector is activated. 

In this example we also introduce some more practical considerations that must be considered in a 

simulation: 

• We discuss how the heat release rate for a fire may vary with time. We show one approach to 

calculating this data. 

• We demonstrate how to add a control, so that smoke detector activation will open a closed 

door.  

• We change the reaction to match that described in the New Zealand building code, C/VM2 - 

Verification Method: Framework for Fire Safety Design. 

 

Figure 1. Smoke in the model with air flow in the bottom of the door and out the top. 

In this tutorial you will: 

• Create a fire with a time-varying heat release rate (HRR). 

• Define a new reaction that corresponds to the New Zealand framework for fire safety design. 

• Create a doorway using a hole.  



 

 

 

• Add a smoke detector that opens the door when it activates. 

• Add a flow measurement device to measure heat flow through the door. 

• Add a layer zoning device (to measure layer height). 

Throughout this example, the instructions will describe data input using menu dialogs. This is done for 

clarity and consistency. However, PyroSim provides both drawing tools and shortcut toolbars that can 

speed many of these tasks. The user is encouraged to experiment with these alternate approaches to 

model creation. 

Select SI Units 
To select SI units: 

1. On the View menu, click Units and select SI to display values using the metric system. 

Name and Save the Model 
It is a good idea to save your model at the start. This will make it possible for you to save it at any time in 

the future and return to continue your work. 

1. On the File menu, click Save. 

2. Choose a location to save the model. Because FDS simulations generate many files and a large 

amount of data, it is a good idea to use a new folder for each simulation. For this example, we 

will create a Smoke Layer folder and name the file smoke layer.psm. 

3. Click OK to save the model. 

Reaction based on New Zealand Verification Method  
In this example we will demonstrate how to create a reaction that corresponds to that defined in the 

New Zealand building code, C/VM2 - Verification Method: Framework for Fire Safety Design. The New 

Zealand code defines the fire products, it does not specify the input fuel composition, see Figure 2. 

We will assume the stoichiometric simple chemistry reaction as described in the FDS User Manual 

(Chapter 12). This general relationship is given by: 

𝐶𝑋𝐻𝑌𝑂𝑍𝑁𝑉 + 𝜈𝑂2𝑂2
𝑦𝑖𝑒𝑙𝑑𝑠
→    𝜈𝐶𝑂2𝐶𝑂2 + 𝜈𝐻2𝑂𝐻2𝑂 + 𝜈𝐶𝑂𝐶𝑂 + 𝜈𝑆𝑆𝑜𝑜𝑡 + 𝜈𝑁2𝑁2 

Using this relationship and the specified product species, we can solve for the fuel composition 

𝐶1𝐻2.20209𝑂0.622494. A fuel composition calculator is provided on the PyroSim web site 

(https://www.thunderheadeng.com/pyrosim/resources/).  

 



 

 

 

 

Figure 2: Table from the New Zealand C/VM2 Verification Method: Framework for Fire Safety Design. 
The species yields are defined, not the fuel input. 

To define the reaction (see Figure 3 and Figure 4): 

1. On the Model menu, click Edit Reactions. 

2. Click New. In the Reaction Name box, type NZ Reaction. 

3. Click OK to create the new reaction. 

4. The Fuel Type is the Simple Chemistry Model. 

5. In the Carbon atoms box, type 1. 

6. In the Hydrogen atoms box, type 2.20209. 

7. In the Oxygen atoms box, type 0.622494. 

8. In the Nitrogen atoms box, type 0. 

9. Click the Byproducts tab. 

10. Select Specify heat of combustion and in the box, type 2.0E4. 

11. In the CO Yield box, type 0.04. 

12. In the Soot Yield box, type 0.07. 

13. In the Hydrogen Fraction box, type 0. 

14. Click OK to close the Edit Reactions dialog. 



 

 

 

 

Figure 3: Fuel composition. 

 

Figure 4: The reaction byproducts. 



 

 

 

When FDS runs, it writes a *.out file (in this case smoke.out) that includes the details of the simulation. 

You can verify that the FDS reaction coefficients match the expected values based on our fuel 

component input. 

Create the Fire (Burner Surface) 
It is the responsibility of the fire safety engineer to identify the appropriate fire heat release rate and 

products. As background information, Kim and Lilley (Heat Release Rates of Burning Items in Fires, AIAA 

2000-0722, January 2000) summarized several different experiments, representing the results using t2 

fire for the growth and decay periods, with a constant maximum heat release rate between these two 

periods. This paper is especially useful in demonstrating the broad range of fire time histories and heat 

release rates that can be encountered. A calculator based on this paper can be found on the PyroSim 

support website (https://www.thunderheadeng.com/pyrosim/resources/). 

For this example, we will use the heat release rate shown in Figure 5. This curve was calculated for the 

Chair 2 data set in the Kim and Lilley paper. The detailed results of the calculation for the first 100 

seconds are shown in Figure 6.  In FDS the curve is defined by a nominal Heat Release Rate per Unit Area 

(HRRPUA) value that is multiplied by a factor (RAMP) to obtain the curve. The total heat release rate is 

then obtained by multiplying the HRRPUA by the total surface area of the fire. So, an FDS user must be 

aware of the surface area of the fire, the nominal value of HRRPUA, and the modifying factor.  In this 

example, the surface area of the fire will be 1 m2. 

 

Figure 5: HRR history that represents measured data for a chair with a polypropylene foam frame, 
urethane foam, and polyolefin fabric. This is called Chair 2 in Kim and Lilley (2000). 



 

 

 

 

Figure 6: First 100 seconds of the HRR curve used in this example 

Surfaces are used to define the properties of objects in your FDS model. In this example, we define a 

burner surface that releases heat at the rate shown above in Figure 5. 

1. On the Model menu, click Edit Surfaces. 

2. Click New. 

3. In the Surface Name box, type Fire. 

4. In the Surface Type list, select Burner. 

5. Click OK to create the new default burner surface. 

6. In the Heat Release Rate (HRR) box, type 1960 kW/m2. Note that this corresponds to the peak 

value of HRRPUA.  

7. Select Custom for the Ramp-Up Time. 

8. Click Edit Values enter the time and normalized values given in Figure 6 (also see Figure 7). If 

you prepare the data in two columns, you can paste it directly into the table in one operation. 

Click OK. 

9. Click OK to save changes and close the Edit Surfaces dialog. 



 

 

 

 

Figure 7: The ramp values multiply the specified HRRPUA to define a function in time. 

Create the Mesh 
The mesh defines the solution grid. In this example we will use mesh cells that are 0.1 m across. This 

value is slightly larger than 1/10 of the characteristic diameter (D*) for a 800 kW fire (D*/10=0.088 m). 

As a rule of thumb, this is a reasonable size for initial calculations and should provide a moderate level 

of accuracy in modeling the plume (McGrattan, et al., 2007). Using mesh cells that are smaller by a 

factor of 2 should decrease error by a factor of 4, but will increase the simulation run time by a factor of 

16. 

1. On the Model menu, click Edit Meshes. 

2. Click New. 

3. Click OK to create the new mesh. 

4. In the Min X box, type 0 and in the Max X box, type 5. 

5. In the Min Y box, type 0 and in the Max Y box, type 5. 

6. In the Min Z box, type 0 and in the Max Z box, type 2.4. 

7. In the X Cells box, type 50. 

8. In the Y Cells box, type 50. 

9. In the Z Cells box, type 24. 

10. Click OK to save changes and close the Edit Meshes dialog. 



 

 

 

 

Figure 8. Creating the mesh 

Create the Fire using a Vent 
Vents have general usage in FDS to describe 2D planar objects. Taken literally, a vent can be used to 

model components of the ventilation system in a building, like a diffuser or a return. In these cases, the 

vent coordinates define a plane forming the boundary of the duct. No holes need to be created; air is 

supplied or exhausted by the vent. 

You can also use vents as a means of applying a boundary condition to a rectangular patch on a surface. 

A fire, for example, can be created by specifying a vent on either a mesh boundary or solid surface. The 

vent surface defines the desired characteristics of fire. This is the approach used in this example. 

1. On the Model menu, click New Vent. 

2. In the ID box, type Fire vent, Figure 9. 

3. In the Surface list, select Fire. This specifies that the previously created burner surface will 

define the properties of the vent. 

4. Click on the Geometry tab. In the Plane list, select Z. Set the value to 0.0. 



 

 

 

5. In the Min X box, type 4.0 and in the Max X box, type 5.0. 

6. In the Min Y box, type 0.0 and in the Max Y box, type 1.0. 

7. Click OK to create the new burner vent. 

 

Figure 9. Creating the fire vent 

Create the Open Vent outside the Door 
We will place an open vent outside the door. This means that the default ambient conditions will exist 

outside and that air can flow in and smoke flow out through this open vent. This is a nice way to 

simulate the flow out of a door, both because it lets you visualize the smoke outside the door and 

because the air flow through the door is affected by the outside ceiling and floor.  

1. On the Model menu, click New Vent. 

2. In the ID box, type Open side. 

3. In the Surface list, select OPEN. This is a default surface that means this will be an open 

boundary. 

4. Click on the Geometry tab. In the Plane list, select Y and type 5. 

5. In the Min X box, type 0 and in the Max X box, type 5. 

6. In the Min Z box, type 0 and in the Max Z box, type 2.4. 

7. Click OK to create the open vent. 

Add the Wall 
In FDS obstructions are used to define solid objects in the model. In this example, we will use an 

obstruction to define a wall. 

1. On the Model menu, click New Obstruction. 



 

 

 

2. In the ID box, type Wall. 

3. Click on the Geometry tab. 

4. In the Min X box, type 0 and in the Max X box, type 5. 

5. In the Min Y box, type 4 and in the Max Y box, type 4.2. 

6. In the Min Z box, type 0 and in the Max Z box, type 2.4. 

7. Click OK to create the wall obstruction. 

Add a Door 
In FDS holes are used to define openings through solid objects. In this example, we will use a hole to 

represent a door. The alternate approach is to represent the wall with three obstructions (left, right, and 

top) and then have a fourth obstruction for the door. The hole is simpler, but either approach can work. 

To make the hole:  

1. On the Model menu, click New Hole. 

2. In the ID box, type Door. 

3. Click the Geometry tab.  

4. In the Min X box, type 2 and in the Max X box, type 3. In the Min Y box, type 3.9 and in the Max 

Y box, type 4.3. In the Min Z box, type 0.0 and in the Max Z box, type 2.0. 

5. Click OK to create the doorway hole. 

Add a Smoke Detector 
We will make a smoke detector that will be used in a control that opens the door when the detector 

activates. To make the smoke detector: 

1. On the Devices menu, click New Smoke Detector. 

2. In the Name box, type Smoke detector. We will use the default Cleary Ionization I1 detector. 

3. We position the detector near the ceiling in the center of the room. For Location, in the X box, 

type 2.5, in the Y box, type 2, and in the Z box, type 2.3 (just below the ceiling). 

4. The default Orientation points the detector in a –Z direction and does not need to be changed. 

5. Click OK to create the smoke detector. 

Add a Control to Open the Door when Smoke is Detected 
Now we have a smoke detector and a door. We want to keep the door closed until smoke is detected, 

then simulate someone leaving the room with an open door. To do this, we must tie the detector and 

the door together with a control. 

1. On the Devices menu, click Edit Activation Controls. 

2. Click New and in the Name box, type Smoke detector control. Click OK. 

3. For the Input Type select Detector. This means that the control will rely on input from the 

smoke detector to perform its assigned tasks. 

4. Since the Door is a hole, we want to activate the Door (hole) when smoke is detected. So the 

Action to Perform is to Activate. 



 

 

 

5. Now click on the first <nothing> and select Door from the list, so the Door will be created. Click 

OK. 

6. Now click on the second <nothing> and select Smoke detector from the list. Now we can see 

the logic associated with the control. The Door will activate (be created) when the Smoke 

detector activates. Click OK. 

7. Click OK to create the control and close the Activation Controls dialog. 

 

Figure 10: Creating the control that opens the door when the smoke detector activates. 

Spin the Model for a Better View 
1. To reset the zoom and properly center the model, press CTRL + R. PyroSim will now be looking 

straight down at the model along the Z axis. 

2. Press the left mouse button in the 3D View and drag to spin the model. Note that the door hole 

is displayed, but in the final results view will only appear when activated. 



 

 

 

 

Figure 11. The model after rotating. The burner is shown in red and the open vent in blue 

Add a Layer Zoning Device 
FDS estimates the location of the interface between the hot, smoke-laden upper layer and the cooler 

lower layer in a burning compartment (see the FDS manual for details). This is calculated using a special 

Layer Zoning Device. To create the device: 

1. On the Devices menu, click New Layer Zoning Device. 

2. In the Name box, type Layer Zone. 

3. Click the options to Measure Layer Height, Measure Upper Temperature, and Measure Lower 

Temperature. We will not use setpoints, but enabling setpoints would make it possible to use 

the layer data to activate a control.  

4. For the End Point 1 coordinates, in the X box, type 2.5, in the Y box, type 2.5, and in the Z box, 

type 0. 

5. For the End Point 2 coordinates, in the X box, type 2.5, in the Y box, type 2.5, and in the Z box, 

type 2.4. 

6. Click OK to create the layer zoning device. It will be displayed as a line in the model. 

Add a Flow Measuring Device 
In addition to point measurements (such as thermocouples or smoke detectors), FDS supports more 

general options to evaluate parameters on planes or in volumes. We will use a planar device to measure 

heat flow through the door.  

1. On the Devices menu, click New Flow Measuring Device. 



 

 

 

2. In the Device Name box, type Door Heat Flow. 

3. In the Quantity options, select Heat Flow. 

4. In the Plane list, select Y and type 4. 

5. In the Min X box, type 2 and in the Max X box, type 3. 

6. In the Min Z box, type 0 and in the Max Z box, type 2. 

7. Click OK to create the flow measuring device. It will appear as a yellow plane in the model. 

Add a Slice Planes to Display Velocity Vectors 
We will use a slice plane to display the velocity vectors of flow through the door. 

1. On the Output menu, click 2D Slices. 

2. In the XYZ Plane column, select X. 

3. In the Plane Value column, type 2.5. 

4. In the Gas Phase Quantity column, click Velocity. 

5. In the Use Vector? column, select YES. 

6. In the Cell Centered? column, select NO. 

7. Add a second row to plot Temperature. Do not use vectors. 

8. Click OK to create the slice planes. 

On the toolbar, you can click the Show Slices button to toggle the slice planes on and off. 

Set the Simulation Time 
1. On the Analysis menu, click Simulation Parameters. 

2. On the Time panel, in the End Time box, type 50. Although the fire is still growing at 50 seconds, 

it is sufficient to activate the smoke detector, open the door, and illustrate smoke flowing out 

the door.  

3. Click OK to save the simulation parameters. 

Save the model 
1. On the File menu, click Save. 

Run the Simulation 
1. On the FDS menu, click Run FDS. 

2. The FDS Simulation dialog will appear and display the progress of the simulation.  

3. When the simulation is complete, PyroSim Results should launch automatically and display a 3D 

still image of the model. 

View Smoke in 3D 
We will first view the smoke and reaction volumes. 

1. In the PyroSim Results window, double click 3D Smoke to load the HRRPUV and Soot Mass 

Fraction datasets. 



 

 

 

 

Figure 12. 3D Smoke and fire in the model 

View the Velocity and Temperature Slices 
We now display the velocity profile. 

1. In the tree, expand Slice Vectors and double click VELOCITY. This will load the vector slice data. 

2. Double-click the Temperature 2D Slice to see a contour of temperatures. At this time, we can 

see the development of hot and cool zones, the smoke in the room, and the flow of hot air out 

the top of the door and cold air in the bottom of the door. 



 

 

 

 

Figure 13: Velocity vectors in the model. 

 

Figure 14: Temperature slice 



 

 

 

View Time History Data 
We will explore just some of the time history data. 

1. In the PyroSim window, on the Analysis menu, click Plot Time History Results. 

2. A dialog will appear showing the different types of 2D results that are available. Select 

smoke_hrr.csv and click Open to view the device output. The first display will be the heat 

release rate, Figure 15. At 50 seconds, the expected value is the ramp fraction (0.128) multiplied 

by the HRRPUA (1960 kW/m2), multiplied by the surface area (1 m2), to obtain a value of 251 

kW. This matches the calculated result. 

3. Now click Plot Time History Results, select smoke_ctrl.csv and click Open to view the smoke 

detector control output, Figure 16. As can be seen, the smoke detector control activated at 

about 15 seconds and opened the door. 

Note: You can access these plots faster using the graph button on the toolbar.  

 

Figure 15. Time history plot of heat release rate.  



 

 

 

 

Figure 16: Smoke detector control output. 

Summary 
We have completed a fairly complex fire simulation that illustrates what, for most fire protection 

engineers, will be a sufficient approach to modeling a fire by defining a reaction and specifying a heat 

release rate that varies with time. Of course, the engineer will be required to determine the exact fire 

composition for the reaction and the heat release rate time history. 

Other important points in this model include the user of a smoke detector device to activate a control 

that opened a door and the display of results.  
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